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Abstrakt
V práci je prezentovaný postup spracovania digitálnych snímok zachytávajúcich vlákna si-
nice Nostoc za účelom merania ich dĺžky. Predstavený je algoritmus využívajúci Houghovu
transformáciu na vyhodnotenie náväznosti vlákien v miestach ich priesečníkov. Algoritmus
je demonštrovaný na vybraných snímkach, skúmané vlákna sú separované a vyhodnotené
sú ich dĺžky. Súčasťou práce je softvér realizujúci prezentovaný algoritmus vo vývojovom
prostredí Delphi.

Abstract
This thesis presents an image processing approach to estimating the length of cynobac-
teria strands in digitally acquired images. An algorithm utilizing the Hough transform
to determine strand continuity at strand intersections is presented. The algorithm is de-
monstrated on selected images, the examined strands are separated and their lengths are
estimated. A Delphi implementation of the algorithm is included.
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digitálna krivka, pretínajúce sa objekty, Houghova transformácia, spracovanie obrazu
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Úvod
Medzi často sa vyskytujúce problémy v obore analýzy obrazu patrí extrakcia vlastností
objektov, ktoré sa v danom obraze nachádzajú. Na to, aby mohli byť tieto objekty ana-
lyzované, je najprv nutné ich v obraze správne identifikovať. V závislosti od skúmaných
vlastností existuje na riešenie tohto problému viacero matematických metód – príkladom
je Houghova transformácia na detekciu parametricky vyjadriteľných rovinných objektov,
najčastejšie priamok. Situácia, kedy sa objekty v obraze prekrývajú alebo pretínajú, pred-
stavuje podstatné sťaženie tejto úlohy. Vychádzajúc zo samotnej podstaty obrazových dát
je tak často nutné metodiku obrazovej analýzy prispôsobiť konkrétnej úlohe.

Predmetom diplomovej práce je numerická analýza prekrývajúcich sa objektov v ob-
raze – analyzované sú snímky vláknitej sinice Nostoc zachytené mikroskopom, pričom
vlastnosťou, ktorá má byť vyhodnotená, je ich dĺžka. Každá zo súboru spracovávaných
snímok obsahuje niekoľko vlákien, ktoré sa v určitých miestach pretínajú. Rutinná apli-
kácia štandardných metód detekcie objektov v obraze nie je v tomto prípade postačujúca,
nakoľko pred vyčíslením dĺžky vlákna je nutné dané vlákno separovať od vlákien ostat-
ných.

V práci je predstavený algoritmus, ktorý separáciu vlákien realizuje. Houghova trans-
formácia, ktorá je nástrojom na detekciu priamok v šedotónovom obraze, nachádza v al-
goritme nové uplatnenie – využitá je na lokálnu aproximáciu „sklonu“ krivky v miestach,
kde sa táto krivka pretína s krivkou inou. Na základe tejto informácie sú následne krivky
v obraze automaticky trasované, čo umožňuje ich separáciu odpovedajúcu vizuálnemu po-
súdeniu a vyhodnoteniu človekom. Okrem „sklonu“ využíva algoritmus niektoré historické
informácie o správaní sa danej krivky v minulosti.

V kapitole 1 sú uvedené vybrané definície a vety týkajúce sa binárnych relácií, metric-
kých priestorov a operácie konvolúcie, na základe ktorých je neskôr postavená matema-
tická teória digitálneho obrazu a jeho spracovania.

V prvej časti kapitoly 2 je definovaný digitálny obraz a spomenuté sú jeho základné
vlastnosti. V jej druhej časti sa nachádza matematický opis vybraných numerických metód
spracovania obrazu, ktoré sú pri samotnej analýze použité.

Kapitola 3 opisuje postup predspracovania obrazových dát a ich prípravy na proces
separácie objektov, ktoré zachytávajú. Uplatnené sú postupy a metódy z kapitoly 2 –
snímky boli lineárne filtrované, segmentované a upravované vybranými morfologickými
operáciami a numerickými metódami.

V kapitole 4 je predstavený samotný algoritmus, ktorý vykonáva separáciu pretínajú-
cich sa kriviek v binárnom obraze. Opis algoritmu je doprevádzaný ukážkou jeho krokov
na jednej zo spracovávaných snímok. Uvedená je metodika estimácie dĺžky separovaných
kriviek.

Výsledky práce sú zhrnuté v kapitole 5. Dĺžky vlákien siníc nachádzajúcich sa v spra-
covávaných snímkach sú uvedené v tabuľke a zhodnotená je funkčnosť algoritmu.
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1 Matematický aparát
V nematematickom chápaní obraz vidíme ako súbor objektov, o ktorých môžme vysloviť
úsudok, že pozostávajú z bodov. Analýza, ktorá má byť vykonaná, si vyžaduje postup
inverzný. Obraz už vopred považujeme za súbor bodov a až skúmajúc ich vlastnosti na-
chádzame vzťahy určujúce to, ktoré body sú súčasťou jedného objektu. Na matematickú
formalizáciu týchto vzťahov potrebujeme predovšetkým aparát binárnych relácií a nie-
ktoré pojmy súvisiace s metrickými priestormi. Nasledujúce definície je možné považovať
za všeobecne známe, ich formulácia však založená na monografii [1] a prednáškach [2], [3].
Podkapitola o konvolúcii vychádza z [4].

1.1 Binárne relácie

Definícia 1.1.1 (Karteziánsky súčin). Nech A,B sú ľubovoľné množiny. Množinu

A×B :=
{
(a, b) | a ∈ A ∧ b ∈ B

}
nazveme karteziánskym súčinom množín A a B.

Definícia 1.1.2 (Binárna relácia). Nech A,B sú ľubovoľné množiny. Binárnou reláciou
medzi množinami A a B nazveme ľubovoľnú podmnožinu

R ⊆ A×B.

O prvkoch a ∈ A, b ∈ B povieme, že sú v relácií R, a zapíšeme a ∼R b, ak (a, b) ∈ R.
V opačnom prípade zapíšeme a 6∼R b. Ak platí A = B, o R povieme, že je A binárnou
reláciou na množine A.

Na základe toho, ako je relácia na množine určená, môžeme hovoriť o tom, či splňuje
alebo nesplňuje nasledujúce vlastnosti.

Definícia 1.1.3 (Vlastnosti relácie). Nech R je reláciou na A. Povieme, že R je

(i) reflexívna, ak platí a ∼R a pre všetky a ∈ A,

(ii) ireflexívna, ak platí a 6∼R a pre všetky a ∈ A,

(iii) symetrická, ak platí a1 ∼R a2 =⇒ a2 ∼R a1 pre všetky a1, a2 ∈ A,

(iv) antisymetrická, ak platí a1 ∼R a2 ∧ a2 ∼R a1 =⇒ a2 = a2 pre všetky a1, a2 ∈ A,

(v) asymetrická, ak platí a1 ∼R a2 =⇒ a2 6∼R a1 pre všetky a1, a2 ∈ A,

(vi) tranzitívna, ak platí a1 ∼R a2 ∧ a2 ∼R a3 =⇒ a1 ∼R a3 pre všetky a1, a2, a3 ∈ A.

Významným typom relácie na množine je relácia ekvivalencie, ktorá nám umožňuje
danú množinu na základe určitého vzťahu medzi jej prvkami rozdeliť. Pri analýze v kapi-
tole 2 bude práve vhodne definovaná relácia ekvivalencie poskytovať spôsob, ktorý umožní
v obraze rozlišovať objekty od pozadia a objekty medzi sebou.

Definícia 1.1.4 (Rozklad množiny). Nech A 6= ∅ je ľubovoľná množina. MnožinuM⊆
P(A) splňujúcu
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(i) ∅ 6∈ M,

(ii) M1 ∩M2 = ∅ pre všetky M1,M2 ∈M také, že M1 6= M2,

(iii) ⋃M∈M = A,

nazveme rozkladom množiny A. Množiny M ∈M nazveme triedami rozkladu.

Definícia 1.1.5 (Ekvivalencia). Binárnu reláciu na A, ktorá je reflexívna, symetrická
a tranzitívna, nazveme reláciou ekvivalencie na A.

Veta 1.1.1. Nech R je reklácie ekvivalencie na A. Množina

MR :=
{
MR

a | a ∈ A
}
, kde MR

a = {a′ ∈ A | a ∼R a′},

je rozkladom množiny A.

Relácia ekvivalencie definovaná na množine A tak túto množinu rozkladá na systém
navzájom disjunktných podmnožín, ktorých zjednotením je celá množina A.

a

b
Ma

R

Mc
R

Md
R

c
e

d

Obr. 1.1: Rozklad množiny M = {a, b, c, d, e} binárnou reláciou ekvivalencie R =
{(a,a), (b,b), (c,c), (d,d), (e,e), (a,b), (b,a), (d, e), (e, d)}

Nakoľko relácie sú definované ako množiny usporiadaných dvojíc, pomocou klasických
množinových operácií dokážeme zaviesť aj operácie s reláciami.

Definícia 1.1.6 (Operácie s reláciami). Nech R a S sú relácie medzi množinami A a B
a nech T je relácia medzi množinami B a C.

(i) Zjednotením relácií R a S nazveme reláciu

R ∪ S := {(a, b) ∈ A×B : aRb ∨ aSb}.

(ii) Prienikom relácií R a S nazveme reláciu

R ∩ S := {(a, b) ∈ A×B : aRb ∧ aSb}.

(iii) Zložením relácií R a S nazveme reláciu

T ◦R := {(a, c) ∈ A× C : ∃b ∈ B také, že aRb ∧ bTc}.
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(iv) Inverznou reláciou k relácii R nazveme reláciu

R−1 := {(b, a) ∈ B × A : aRb}.

1.2 Metrický priestor

Pri spracovaní obrazu sa nezaobídeme bez konceptu vzdialenosti, ktorého matematickou
formalizáciou je metrika. Aparát metrických priestorov nám mimo iné umožňuje použí-
vať pojem susednosti pixelov, ktorého znalosť je nutná už aj pri základných postupoch
obrazovej analýzy.

Definícia 1.2.1 (Metrika a metrický priestor). Nech M 6= ∅. Zobrazenie % : M ×M →
[0,∞) splňujúce

(i) %(x, y) = 0⇐⇒ x = y

(ii) %(x, y) = %(y, x)

(iii) %(x, z) ≤ %(x, y) + %(y, z)

pre všetky x, y, z ∈ M nazveme metrikou na M . Dvojicu (M,%) nazveme metrickým
priestorom.

Metrika môže byť všeobecne ľubovoľná, ak splňuje vyššie uvedné axiómy. Axióm (i)
nazývame axíom totožnosti – hovoríme, že metrika rozlišuje body. Axióm (ii) je axióm
symetrie a axíom (iii) je nazývaný trojuholníková nerovnosť. Medzi najznámejšie a najbe-
žejšie používané metriky patrí euklidovská metrika, ktorá formalizuje intuitívne chápaný
pojem vzdielnosti v reálnej rovine. V kontexte digitálneho obrazu sa však nepohybujeme
v reálnej rovine, a vhodnejšiou (no nie jednoznačnou) voľbou sa ukazujú byť metriky
súčtová a maximová.

Definícia 1.2.2 (Vybrané metriky). Nech M = Rn, n ∈ N. Metriku definovanú

%1(x, y) :=
n∑
k=1
|xk − yk| (1.1)

nazveme súčtovou (manhattanskou) metrikou. Metriku definovanú

%2(x, y) :=
( n∑
k=1

(xk − yk)2
) 1

2
(1.2)

nazveme euklidovskou metrikou a metriku definovanú

%∞(x, y) := max{|x1 − y1|, |x2 − y2 |, . . . , |xn − yn|} (1.3)

nazveme maximálnou (Chebyshevovou) metrikou.

V predchádzajúcich definíciach predpokladáme, že M je podmnožinou Rn. Pozname-
najme však, že nakoľko platí Zn ⊂ Rn, metriku môžeme používať aj v n-rozmernom
celočíselnom obore, alebo jeho ľubovoľnej neprázdnej podmnožine.
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Definícia 1.2.3 (Guľa). Nech (M,%) je metrický priestor, x0 ∈M a r je kladná reálna
konštanta. Množinu

Br(x0) := {x ∈M : %(x0, x) < r} (1.4)

nazveme otvorenou guľou so stredom v bode x0 a polomerom r. Množinu

Br[x0] := {x ∈M : %(x0, x) ≤ r} (1.5)

nazveme uzravretou guľou so stredom v bode x0 a polomerom r. Špeciálne, guľu s polo-
merom r = 1 nazveme jednotkovou guľou.

Poznámka 1.2.1. Pre ε ∈ R+ nazveme Oε(x0) := Bε(x0) epsilonovým okolím (ε-okolím)
bodu x0.

0 1-1

1

-1

0 0 1-1

1

-1

1-1

1

-1(a) (b) (c)

Obr. 1.2: Jednotková guľa v R×R so stredom v bode (0, 0) pri použití metriky (a) %1 (b)
%2 (c) %∞

1.3 Konvolúcia

Definícia 1.3.1 (Konvolúcia). Nech f, h : R→ R. Funkciu

(f ∗ g)(t) :=
∫ ∞
−∞

f(t)h(t− τ) dτ (1.6)

nazveme konvolúciou funkcie f s konvolučným jadrom h.

Veta 1.3.1 (Vlastnosti konvolúcie). Nech f, g, a h sú reálne funkcie reálnej premennej
a nech a je reálna konštanta. Pre konvolúciu platí

(i) f ∗ g = g ∗ f ,

(ii) f ∗ (g ∗ h) = (f ∗ g) ∗ h,

(iii) f ∗ (g + h) = (f ∗ g) + (f ∗ h),

(iv) a(f ∗ g) = (af) ∗ g = f ∗ (ag).
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Komutativita nám potom umožňuje v definícii 1.3.1 použiť ekvivalentný zápis

(f ∗ g)(x, y) =
∫ ∞
−∞

f(t− τ)h(t) dτ. (1.7)

Aby konvolúcia našla svoje uplatnenie v obore spracovania digitálneho obrazu, je nutné
ju najprv zovšeobecniť pre funkcie dvoch premenných.
Definícia 1.3.2 (Konvolúcia funkcie dvoch premenných). Nech f, h : R × R → R.
Funkciu

(f ∗ g)(t) :=
∫ ∞
−∞

∫ ∞
−∞

f(a, b)h(x− a, y − b) da db = (1.8)

=
∫ ∞
−∞

∫ ∞
−∞

f(x− a, y − b)h(a, b) da db. (1.9)

nazveme konvolúciou funkcie f s konvolučným jadrom h.
Argumentom takto definovanej konvolúcie je reálna funkcia dvoch reálnych premen-

ných. V nasledujúcej kapitole však zavedieme digitálny obraz ako zobrazenie s celočísel-
ným definičným oborom. Budeme preto potrebovať diskrétnu konvolúciu, ktorú získame
nahradením integrálov definícii 1.3.2 konečnými sumami.
Definícia 1.3.3 (Diskrétna konvolúcia funkcie dvoch premenných). Nech f : Z × Z →
R, g : Z× Z→ R. Funkciu definovanú

(f ∗ g)(j, k) :=
∑
m

∑
n

f(j −m, k − n) g(m,n) (1.10)

nazveme diskrétnou konvolúciou funkcie f s konvolučným jadrom (maskou) g.
Konvolúcia je základom procesu lineárnej filtrácie obrazu, ktorá bude opísaná v časti 2.2.

gf

f
*
g

f*g(j, k)

g(0, 0)

f(j, k)

Obr. 1.3: Diskrétna konvolúcia

7



2 Vybrané metódy spracovania obrazu
Z matematického pohľadu obrazom rozumieme zobrazenie priraďujúce bodom svojho defi-
ničného oboru, nazývaných pixelmi, jasovú hodnotu. Toto zobrazenie môže byť všeobecne
definované na akejkoľvek podmnožine reálnej roviny. Nakoľko však cieľom práce je spra-
covanie obrazu digitálneho a samotný proces digitalizácie nemá na uvedené realizované
postupy dopad, budeme v nasledujúcom texte uvažovať výhradne obraz digitálny, a teda
už v jeho definícii budeme predpokladať konečnosť jeho definičného oboru. Obsah tejto
kapitoly vychádza primárne z literárnych zdrojov [4], [5], [6] a [7]. Sekcia 2.5 týkajúca sa
matematickej morfológie je založená na monografiách [8] a [12]. Opis Houghovej transfor-
mácie v časti 2.7 sa opiera o vedomosti vychádzajúce z [11] a [14]. V neposlednej rade sú
využité niektoré poznatky z [13].

2.1 Obraz a jeho vlastnosti

Definícia 2.1.1 (Obraz). Nech M = {1, 2, . . . , h} × {1, 2, . . . , w}, kde h,w ∈ N a nech
R = {0, 1, . . . , 2k − 1}, kde k ∈ N. Šedotónovým obrazom (stručne obrazom) o rozmeroch
h× w a s bitovou hĺbkou k potom nazveme zobrazenie

i : M → R.

Hodnotu i(p) pixelu p = (j, k) nazveme jasovou alebo pixelovou hodnotou pixelu p. Špe-
ciálnym prípadom obrazu je binárny obraz, ktorého obor hodnôt R obsahuje práve dva
prvky, spravidla

R = {0, 1}.

Niekedy ďalej býva vhodné obraz zapisovať v maticovom tvare, ktorý odpovedá rozmiest-
neniu pixelov v rovine a je daný predpisom

I = [ijk], kde ijk = i(j, k).

Konečnosť oboru hodnôt nám dovoľuje pre obraz i1 zadefinovať obraz nový, ktorý je
k i2 v istom zmysle opačný. Takýto obraz je nazývaný komplement obrazu i1.

Definícia 2.1.2 (Komplement obrazu). Nech i1 a i2 sú obrazy o rozmeroch h × w
s bitovou hĺbkou k. Obraz i2 nazveme komplementom obrazu i1, ak

i2(j, k) = (2k − 1)− i1(j,k) pre všetky j = 1, . . . , w, k = 1, . . . , h.

Poznámka 2.1.1. Binárna relácia daná

p ∼ q ⇔ i(p) = i(q) (2.1)

na množineM binárneho obrazu i : M → {0, 1} je reláciou ekvivalencie a podľa vety 1.1.1
tak rozkladá M na podmnožiny

MO = {p ∈M | i(p) = 1},
MB = {p ∈M | i(p) = 0},
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0 0 0 0

0 0 1 0

0 1 1 0

0 1 1 0

0 1 1 1

0 0 0

1 1 0

1 0 0

0 0 0

0 0 0

1 1 1 1

1 1 0 1

1 0 0 1

1 0 0 1

1 0 0 0

1 1 1

0 0 1

0 1 1

1 1 1

1 1 1

Obr. 2.1: Binárny obraz (vľavo) a jeho komplement (vpravo).

pričom

MO ∩MB = ∅, MO ∪MB = M.

Zobrazenie i je zároveň charakteristickou funkciou množiny MO. Potom je zrejmé, že ak
poznáme definičný obor binárneho obrazu, množina MO daný obraz jednoznačne určuje.
Pixely p ∈MO bývajú v kontexte rozpoznávania objektov nazývané objektové pixely, a q ∈
MB pixely pozadia. Ak potom hovoríme o objektoch v obraze, resp. pozadí obrazu, máme
na mysli jeho objektové pixely, resp. pixely pozadia. V prípade, že potrebujeme v obraze
rozlišovať nie len objekty od pozadia, ale aj objekty medzi sebou, musíme zadefinovať
pojem susednosti pixelov.

0 0 0 0

0 0 1 0

0 1 1 0

0 1 1 0

0 1 1 1

0 0 0

1 1 0

1 0 0

0 0 0

0 0 0

MO

MB

MO

Obr. 2.2: Binárny obraz (vľavo) a jeho rozklad reláciou ekvivalencie 2.1 (vpravo).

Definícia 2.1.3 (Susednosť pixelov). Nech η je symetrická binárna relácia na M . O pi-
xeloch p a q povieme, že sú η-susedné, ak

(p, q) ∈ η.

Definícia 2.1.4 (Cesta). Nech A ⊆M , n ∈ N. Postupnosť pixelov

p = p0, . . . , pn = q, kde pk ∈ A pre k = 0, . . . , n,

nazveme η-cestou (digitálnou krivkou) v A medzi p a q, ak

pk−1 a pk sú η-susedné pre všetky k = 1, . . . , n.
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Prirodzené číslo n nazveme dĺžkou cesty (digitálnej krivky). Ďalej povieme, že táto cesta
je jednoduchá, ak pk 6= pl pre všetky indexy k, l ∈ {1, . . . , n}, k 6= l.

Definícia 2.1.5 (Spojené pixely). O pixeloch p, q ∈ A ⊆ M povieme, že sú η-spojené
v A, ak medzi p a q existuje η-cesta v A.

Definícia 2.1.6 (Súvislá podmnožina). Nech A ⊆ M, A 6= ∅. O množine A povieme,
že je η-súvislou podmnožinou, ak ľubovoľné p, q ∈ A sú η-spojené v A.

Nakoľko definícia 2.1.4 pripúšťa triviálne cesty nulovej dĺžky, binárna relácia „byť η-
spojené v A“ je reflexívna. Navyše, už v definícii 2.1.3 predpokladáme symetriu. Ďalej
je ľahké vidieť, že táto relácia je tranzitívna – ak existuje η-cesta medzi p a q a existuje
η-cesta medzi q a r, potom postupnosť

p, . . . , q, . . . r

je η-cestou medzi p a r. Binárna relácia „byť η-spojené v A“ je tak reláciou ekviva-
lencie a podľa vety 1.1.1 množinu A rozkladá na η-súvislé podmnožiny, ktoré nazveme
η-komponenty.

Relácia η môže byť zavedená rôzne – stačí, že splňuje predpoklady definície 2.1.3.
V práci však budeme rozlišovať len dve, a to

(p, q) ∈ η4 práve vtedy, keď p 6= q ∧ %1(p, q) ≤ 1,
(p, q) ∈ η8 práve vtedy, keď %∞(p, q) = 1.

kde %1 a %∞ sú metriky zavedené v časti 1.2. Ľahko si všimneme, že definičný obor obrazu
spolu s jednou z metrík %1, %∞ tvorí metrický priestor.

p p pp

Obr. 2.3: Pixel p, množina N4(p) a množina N8(p).

S cieľom zjednodušenia budeme namiesto η4-susednosti, resp. η8-susednosti používať
výraz 4-susednosť, resp. 8-susednosť. Množinu 4-susedných, resp. 8-susedných pixelov pi-
xelu p obrazu i : M → R označme

N 4
i (p) := {q ∈M | (p, q) ∈ η4} resp. N 8

i (p) := {q ∈M | (p, q) ∈ η8}.
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Ďalej označmeOi(p) množinu tých 8-susedných pixelov pixelu p obrazu i : M → {0, 1},
ktoré sú objektové, t. j.

Oi(p) := {q ∈ N 8
i (p) | i(q) = 1}. (2.2)

2.2 Lineárna filtrácia

Nakoľko obraz je podľa definície 2.1.1 funkciou dvoch celočíselých premenných, môžeme
naň aplikovať operáciu diskrétnej konvolúcie dvoch premenných definovanej v časti 1.3.
Túto operáciu nazývame lineárna filtrácia alebo lineárny filter.

Definícia 2.2.1 (Lineárna filtrácia). Nech i1 je obraz s rozmermi h×w a g je zobrazenie

{−a, . . . , 0, . . . , a} × {−b, . . . , 0, . . . , b} → Z, a, b ∈ N.

Obraz i2 s rozmermi h× w a pixelovými hodnotami

i2(j, k) =
a∑

s=−a

b∑
t=−b

g(s, t) i(j + s, k + t)

nazeveme lineárnou filtráciou obrazu i1 s konvolučným jadrom g. Konvolučné jadro môžme
zapísať v tvare (2a+ 1)× (2b+ 1) matice G = [gjk], kde

gjk = g(j − a− 1, k − b− 1).

Matica G tak má nepárny počet stĺpcov, nepárny počet riadkov a prvok, ktorý sa
v nej nachádza „uprostred“, odpovedá hodnote g(0, 0). Na základe výberu konvolučného
jadra rozlišujeme dva významné typy lineárnych filtrov:

(i) filter typu horná priepusť,

(ii) filter typu dolná priepusť.

Filtre typu dolná priepusť sú základnom väčšiny metód vyhladzovania obrazu. Nahra-
dením hodnoty pixelu (j, k) vhodným váženým priemerom hodnôt pixelov z jeho okolia
dochádza k redukcii rozdielu v jasovej hodnoty medzi susednými pixelmi. Použitím filtru
typu dolná priepusť dochádza v obraze k potlačeniu vysokých frekvencií, zatiaľ čo frek-
vencie nízky sú zachované. Váhy, ktoré sú pri výpočte priemeru použité, sú dané prvkami
konvolučnej matice. Voľbou

G = Gn×n = 1
g11 + g12 + . . .+ gnn


g11 g12 · · · g1n
g21 g22 · · · g2n
... ... . . . ...
gn1 gn2 · · · gnn

 , kde gij = 1 pre všetky i, j,
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dostávame n× n filter kĺzavého priemeru. Ak za prvky gij zvolíme hodnoty aproximujúce
dvojrozmernú Gaussovu funkciu,

G3×3 = 1
16

1 2 1
2 4 2
1 2 1

 , G5×5 = 1
256


1 4 6 4 1
4 16 24 16 4
6 24 36 24 6
4 16 24 16 4
1 4 6 4 1

 ,

dostávame Gaussov filter.

Obr. 2.4: Pôvodný obraz, jeho úprava filtrom kĺzavého priemeru 3× 3 a
Gaussovym filtrom 5× 5.

Naopak, filtre typu horná priepusť obraz zostrujú. Pixelová hodnota pixelu (j,k) je
opäť nahradená váženým priemerom hodnôt pixelov z jeho okolia – váhy sú však volené
tak, aby sa ich jasový rozdiel zvýšil. Dochádza tak k potlačeniu nízkych frekvencií, zatiaľ
čo vysoké frekvencie sú zachované. Príkladom filtru typu dolná priepusť je lineárny filter
s konvolučným jadrom

G3×3 = 1
9

−1 −1 −1
−1 8 −1
−1 −1 −1

 .
Filtre typu dolná priepusť nachádzajú využitie pri potlačovaní šumu v obraze. Na

druhú stranu, filtre typu horná priepusť síce obraz doostria, amplifikujú však aj šum,
ktorý sa v nich nachádza.

2.3 Mediánová filtrácia

Podobne ako filter lineárny, mediánový filter upravuje jasovú hodnotu pixelu p = (j, k)
obrazu i1 na základe jasových hodnôt pixelov z jeho okolia. Namiesto váženého priemeru
týchto hodnôt je však použitý ich medián, čím je potlačený nežiadúci vplyv impulzného
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šumu. Ak za okolie pixelu p považujeme množinu jeho 8-susedných pixelov, po filtrácii
dostávame obraz i2, ktorého jasové hodnoty sú

i2(p) := median
{
i(j − 1, k − 1), i(j − 1, k), i(j − 1, k + 1),
i(j, k − 1), i(j, k + 1), (2.3)
i(j + 1, k − 1), i(j + 1, k), i(j + 1, k + 1)

}
.

2.4 Prahovanie

V časti 2.1 bolo ukázane, že ak pracujeme s binárnym obrazom, dokážeme jeho definičný
obor bez veľkej snahy rozložiť na dve triedy – množinu objektových pixelov a množinu pi-
xelov pozadia. Ak teda chceme rozlišovať objekty od pozadia v obraze šedotónovom, stačí
nám tento obraz vhodným spôsobom previesť na obraz binárny. Jedným z najjednodušších
spôsobov, ako tento prevod docieliť, je prahovanie.

Prepokladajme, že obraz zachytáva, voľné povedané, „svetlé“ objekty na „tmavom“
pozadí. Proces prahovania obrazu i1 : M → R potom spočíva vo vytvorení binárneho
obrazu

i2 : M → {0, 1}, kde i2(j, k) :=
1 ak i1(j, k) < T,

0 ak i1(j, k) ≥ T,
(2.4)

kde T ∈ R je prahová hodnota. Pixely binárneho obrazu s hodnotou 1 sú potom ob-
jektovými a pixely s hodnotou 0 sú pixelmi pozadia. Hodnotu T dokážeme určiť napr.
vizuálnym posúdením histogramu obrazu – za platnosti predpokladu vzájomne rôzneho
jasu objektov a pozadia je histogram obrazu bimodálny a prirodzenou voľbou pre prah T
je tak lokálne minimum nachádzajúce sa medzi vrcholmi histogramu.

Obr. 2.5: Pôvodný obraz a binárny obraz získaný jeho prahovaním.

V publikácii [9] je predstavený iteračný výpočet, ktorým je proces voľby prahovej
hodnoty T možné automatizovať:

(i) V kroku t = 0 zvolíme počiatočnú hodnotu T (0) = 1
hw

∑h
j=1

∑w
k=1 i1(j, k).

(ii) Prahovaním zostrojíme množinu M
(t)
O objektových pixelov obrazu a množinu M

(t)
B

pixelov pozadia.
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(iii) Vyčíslime

µ
(t)
O = 1

|M (t)
O |

∑
(j,k)∈M(t)

O

iin(j, k), µ
(t)
B = 1

|M (t)
B |

∑
(j,k)∈M(t)

B

iin(j, k).

(iv) Položíme T (t+1) = (µ(t)
O + µ

(t)
B )/2 a pokračujeme od bodu (ii).

(v) Výpočet zastavíme po dosiahnutí podmienky |T (t) − T (t+1)| < ε pre zvolené ε ∈ R.

Klasické prahovanie môže zlyhať, ak je pozadie obrazu nerovnomerné – optimálna
prahová hodnota môže byť pre jeho rôzne časti výrazne odlišná. V takom prípade je nutné
prahovať adaptívne – obraz rozdeliť a jeho časti prahovať samostatne. Definičný obor M
obrazu i : M → R delíme na disjunktné, vo väčšine prípadov obdĺžnikové podmnožiny,
ktorých zjednotením je celá množina M . Ak to situácia vyžaduje, proces je možné ďalej
zdokonaliť určením vlastnej prahovej hodnoty pre každý pixel obrazu vhodnou metódou
interpolácie medzi prahovými hodnotami jeho častí.

T1 T2 T3 T4

T5 T6 T7 T8

T9 T10 T11 T12

Obr. 2.6: Obraz a jeho rozklad na 12 podmnožín s vlastnými prahovými
hodnotami T1, . . . , T12.

2.5 Morfologické operácie

V súlade s poznámkou 2.1.1 sa môžeme na objekty v binárnom obraze pozerať ako na
množiny pixelov. Vychádzajúc zo základných množinových operácií, matematická mor-
fológia poskytuje teoretický aparát umožňujúci skúmať a spracovávať tvar obrazových
štruktúr. Základne morfologické operácie sú definované prostredníctvom známych operá-
cií zjednotenia, prieniku a komplementu, a o niečo menej používaných operácií translácie
a reflexie.

Definícia 2.5.1 (Reflexia množiny). Nech A ⊂ Z2. Množinu

Â = {b | b = −a, kde a ∈ A}

nazveme reflexiou množiny A.
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(0,0)

A

Â

(0,0)

Obr. 2.7: Reflexia Â množiny A.

Definícia 2.5.2 (Translácia množiny). Množinu

(A)z = {b | b = a+ z, kde a ∈ A}

nazveme transláciou množiny A bodom z = (z1, z2) ∈ Z2.

A (A)z

Obr. 2.8: Translácia (̂A)z, z = (0, 1) množiny A.

2.5.1 Dilatácia a erózia
Nasledujúce definície predstavujú základné morfologické úpravy binárneho obrazu. Mno-
žinu jeho objektových pixelov upravujú prostredníctvom štruktúrneho elementu. Medzi
základné operácie patria dilatácia a erózia, pomocou ktorých následne zadefinujeme ope-
rácie otvorenia a uzavretia.

Definícia 2.5.3 (Dilatácia množiny). Nech A,B ⊆ Z2. Množinu

A⊕B := {z ∈ Z2 | (B̂)z ∩ A 6= ∅}

nazveme dilatáciou množiny A štruktúrnym elementom B. Ekvivalentne,

A⊕B :=
⋃
b∈B

(A)b.

Definícia 2.5.4 (Erózia množiny). Nech A,B ⊆ Z2. Množinu

A	B := {z ∈ Z2 | (B)z ⊆ A}
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nazveme eróziou množiny A štruktúrnym elementom B. Ekvivalentne,

A	B :=
⋂
b∈B

(A)−b.

Poznámka 2.5.1 (Rozmer a značenie štruktúrneho elementu). Štruktúrny element B ∈
Z2 nazveme štruktúrnym elementom (rozmeru) (2n+ 1)× (2n+ 1), ak

n = max
s∈S
{s}, kde S = {s | s = max{b1, b2}, (b1, b2) ∈ B} (2.5)

a zapisovať ho budeme v tvare mriežky

B =


b−n,−n · · · b−n,n

... . . . ...
bn,−n · · · bn,n

 , (2.6)

pričom na pozíciu bj,k zapíšeme symbol „1“, ak (j, k) ∈ B, a symbol „×“, ak (j, k) 6∈ B.

Za predpokladu, že počiatok (0, 0) ∈ B, výsledkom dilatácie A⊕ B je množina obsa-
hujúca všetky body množiny A a tie body, ktoré patria do množiny A posunutej o b ∈ B.
Dilatácia tak množinu objektových pixelov rozširuje. Výsledkom erózie A	B je množina
bodov, ktoré patria zároveň do A a do A posunutej o −b, b ∈ B. Erózia potom mno-
žinu objektových pixelov zužuje. Všeobecne, pixel (j, k) binárneho obrazu i je po erózii
vyhodnotený ako objektový práve vtedy, keď

i(j + b1, k + b2) = 1 pre ∀ (b1, b2) ∈ B. (2.7)

Obr. 2.9: Pôvodný binárny obraz, binárny obraz po dilatácii, binárny obraz po
erózii a užitý štruktúrny element 2.6. Hranice pixelov sú zvýraznené za účelom
prehľadnosti.

Veta 2.5.1 (Vlastnosti dilatácie a erózie). Nech A,B,B1, B2 ∈ Z2. Potom platí

(i) (A⊕B1)⊕B2 = A⊕ (B1 ⊕B2),

(ii) (A	B1)	B2 = A	 (B1 ⊕B2),

(iii) (A	B)c = Ac 	 B̂,
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Asociatívnosť (i) nám umožňuje implementovať „veľké“ dilatácie ako niekoľko po sebe
nasledujúcich „malých“ dilatácii. Podobne, vlasnosť (ii) umožňuje to isté pre eróziu. Pred-
pokladáme pri tom, že štruktúrny element B dokážeme vyjadriť ako

B = B1 ⊕B2 ⊕ · · · ⊕Bn, n ∈ N.

Vzťah (iii) vyjadruje dualitu týchto operácii – dilatácia objektových pixelov je to isté,
ako erózia pozadia s reflektovaným štruktúrnym elementom. Vďaka dualite nie sme pri
implementácii nútení uvažovať obe operácie zároveň – eróziu objektov v obraze doká-
žeme vykonať prostedníctvom dilatácie pozadia a naopak. Navyše je postačujúce, aby
sme dokázali tieto operácie vykonávať na množine objektových pixelov a zároveň aby sme
dokázali z obrazu vytvoriť jeho komplement. Dilatácia, resp. erózia pozadia obrazu je
potom komplementom dilatácie, resp. erózie množiny objektových pixelov komplementu
komplementu pôvodného obrazu.

2.5.2 Uzavretie a otvorenie
Dilatácia štruktúrnym elementom B a následná erózia týmto elementom umožňuje z ob-
razu odstrániť šum v podobe „dier“ v množine objektových pixelov, t. j. nežiadúce pixely
pozadia spôsobujúce nesúvislosť objektov. Naopak, erózia a následna dilatácia z obrazu
odstaňuje šum v podobe nežiadúcich objektových pixelov. Tieto operácie sú nazývané
uzavretie a otvorenie.

Definícia 2.5.5 (Uzavretie množiny). Nech A,B ⊆ Z2. Množinu

A •B := (A⊕B)	B

nazveme uzavretím množiny A štruktúrnym elementom B.

Definícia 2.5.6 (Otvorenie množiny). Nech A,B ⊆ Z2. Množinu

A ◦B := (A	B)⊕B

nazveme otvorením množiny A štruktúrnym elementom B.

Obr. 2.10: Pôvodný binárny obraz, binárny obraz po otvorení, binárny obraz po
uzavretí a užitý štruktúrny element 2.6. Hranice pixelov sú zvýraznené za účelom
prehľadnosti.
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2.5.3 Hit-or-miss transformácia
Podmienka 2.7 hovorí, ktoré pixely z okolia skúmaného pixelu musia byť objektové, aby
bol aj skúmaný pixel po erózii vyhodnotený ako objektový. Túto podmienku dokážeme
zosilniť tak, že z okolia skúmaného pixelu Navyše vyberieme pixely, od ktorých budeme
vyžadovať, aby boli pixelmi pozadia. Táto operácia je nazývaná hit-or-miss transformácia
a je základným prostriedkom na rozpoznávanie vzorov v binárnom obraze.

Definícia 2.5.7 (Hit-or-miss transformácia). Nech A,B1, B2 ⊆ Z2, B1 ∩B2 = ∅. Mno-
žinu

A�B := (A	B1) ∩ (Ac 	B2),

kde Ac značí komplement množiny A, nazveme hit-or-miss transformáciou množiny A
(zloženým) štruktúrnym elementom B = (B1, B2).

Zložené štruktúrne elementy budeme značiť v tvare mriežky 2.6, pričom na pozíciu
bj,k zapíšeme symbol „1“, ak (j, k) ∈ B1, symbol „0“, ak (j, k) ∈ B2 a symbol „×“, ak
(j, k) 6∈ B1 ∪ B2. Pomocou hit-or-miss transformácie teraz dokážeme definovať operáciu
stenčenia a sekvenčného stenčenia.
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Obr. 2.11: Hit-or-miss transformácia štruktúrnym elementom B8 (vzťahy 2.8)

Definícia 2.5.8 (Stenčenie). Nech A,B1, B2 ⊆ Z2, B1 ∩B2 = ∅. Množinu

A⊗B := A \ (A�B)

nazveme stenčením množiny A (zloženým) štruktúrnym elementom B = (B1, B2).

Definícia 2.5.9 (Sekvenčné stenčenie). Nech A ⊆ Z2 a nech {Bk}nk=1, kde n ∈ N, je
postupnosť zložených štruktúrnych elementov Bk = (Bk

1 , B
k
2 ), Bk

1 , B
k
2 ⊆ Z2. Množinu

A⊗ {Bk}nk=1 := ((· · · ((A⊗B1)⊗B2) · · · )⊗Bn)

nazveme sekvenčným stenčením množiny A postupnosťou (zložených) štruktúrnych ele-
mentov B1, . . . , Bn.
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Pri sekvenčnom stenčení je obvykle používaná nasledujúca postupnosť štruktúrnych
elementov pozostávajúca z B1, B2 a ich troch rotácií o 90°, 180° a 270° okolo počiatku.

B1 =

0 0 0
× 1 ×
1 1 1

 , B2 =

× 0 0
1 1 0
× 1 ×

 , B3 =

1 × 0
1 1 0
1 × 0

 , B4 =

× 1 ×
1 1 0
× 0 0

 ,
(2.8)

B5 =

1 1 1
× 1 ×
0 0 0

 , B6 =

× 1 ×
0 1 1
0 0 ×

 , B7 =

0 × 1
0 1 1
0 × 1

 , B8 =

0 0 ×
0 1 1
× 1 ×

 .
Sekvenčné stenčenie je opakované iteračne až do stavu idempotencie, t. j. do vtedy, kým
sa v obraze nenachádza žiaden zo vzorov 2.8. Výsledkom je obraz pozostávajúci z čiar
širokých 1 pixel zachovávajúci súvislosť komponent.

Obr. 2.12: Pôvodný obraz a jeho sekvenčné stenčenie

2.5.4 Geodetická dilatácia
Operácia dilatácie bola v sekcii 2.5.1 bola zavedená ako zjednotenie posunutí vstupnej
množiny, ktoré sú určené štruktúrnym elementom. Niektoré situácie si môžu vyžadovať
výslednú množinu obmedziť tak, aby výsledkom nebolo celé zjednotenie, ale len jeho
vhodná podmnožina.

Definícia 2.5.10 (Geodetická dilatácia). Nech B,X ⊆ Z2. a nech A ⊆ X Množinu

A⊕X B := (A⊕B) ∩X

nazveme geodetickou dilatáciou množiny A štruktúrnym elementom B s maskou X.

Maska X tak pôsobí ako obmedzenie šírenia dilatácie – vymedzuje body, o ktoré môže
byť množina A rozšírená. Okrem predpokladu A ⊆ X, ktorý má pri aplikácii v obraze
podobu

i(j, k) ≤ iX(j, k) pre j = 1, . . . , h, k = 1, . . . , w,

ďalej vyžadujeme, aby vstupný obraz i a maskovací obraz iX mali totožné rozmery, resp.
definičný obor.

19



Obr. 2.13: Pôvodný binárny obraz, binárny obraz po geodetickej dilatácii a pou-
žitý maskovací obraz. Hranice pixelov sú zvýraznené za účelom prehľadnosti.

2.6 Flood fill

Definícia 2.6.1 (Flood fill). Nech i1 : M → {0, 1} je binárny obraz, MO 6= ∅ množina
jeho objektových pixelov, MB 6= ∅ množina pixelov pozadia, p ∈ MB a n,m ∈ N. Ďalej
nech

MB =
n⋃
k=1

Kk,

kde K1, . . . Kn sú η-komponenty množiny MB. Operácia flood fill je zobrazenie

(i1, p) 7→ i2,

pričom obraz i2 je binárny obraz s definičný oborom M splňujúci

i2(q) =
1, ak q ∈ K,
i1(q) inak.

kde K ∈ {K1, . . . , Kn} je tá η-komponenta množiny MB, ktorá obsahuje p.

Obr. 2.14: Obraz a jeho uprava operáciou flood fill kde η = η4 a p je jeho stredový pixel.
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Operácia flood fill tak upravuje binárny obraz rozšírením jeho množiny objektových
pixelov vstupného obrazu o tie body, ktoré patria do jednej zvolenej komponenty jeho
množiny pixelov pozadia. Všeobecne býva definovaná pre ľubovoľný (nie nevyhnutne bi-
nárny) obraz a pre ľubovoľný počiatočný pixel. Na účely práce je však uvedená definícia
postačujúca. Implementácia je realizovateľná rekurzívnym algoritmom [10]

Algoritmus 1: Flood fill (pre η = η8)
vstupné dáta: p = (j, k)

1 if i(p) = 0 then
2 Nastav i(p) := 1
3 Vykonaj Flood fill s p = (j + 1, k)
4 Vykonaj Flood fill s p = (j, k + 1)
5 Vykonaj Flood fill s p = (j − 1, k)
6 Vykonaj Flood fill s p = (j, k − 1)
7 Vykonaj Flood fill s p = (j + 1, k + 1)
8 Vykonaj Flood fill s p = (j + 1, k − 1)
9 Vykonaj Flood fill s p = (j − 1, k + 1)

10 Vykonaj Flood fill s p = (j − 1, k − 1)
11 end

2.7 Houghova transformácia

Houghova transformácia je numerická metóda na rozpoznávanie priamok, kružníc a iných
matematicky vyjadriteľných kriviek v binárnom obraze. S ohľadom na ciele práce sa v
nasledujúcom opise zameriame na priamky

y = ax+ b.

Aby sme však zohľadnili aj priamky kolmé na os x, budeme používať normálový tvar

% = x cos θ + y sin θ, (2.9)

kde % je kolmá vzdialenosť priamky od počiatku a θ je uhol, ktorý zviera táto kolmica
s osou x. Množina všetkých priamok v obraze tvorí dvojparametrickú sústavu. Ak obme-
dzíme θ na interval [0, π), priamka je určená práve jedným bodom (θ0, %0) v parametric-
kom priestore. Potom kolineárne body v rovine (x, y) zodpovedajú sústave sinusiodálnych
kriviek s práve jedným priesečníkom (θ0, %0), ktory túto priamku určuje.
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Obr. 2.15: Dva body určujúce priamku v rovine (x, y) a odpovedajúce sinusoidy
určujúce parametre tejto priamky v parametrickom priestore.

Pri detekcii priamok v obraze i s rozmermi h×w pristupujeme k numerickému riešeniu.
Premenné v rovnici 2.9 transformujeme tak, aby zodpovedali orientácii osí a súradniciam
pixelov obrazu

j = −y, k = x =⇒ % = k cos θ − j sin θ.

Rovinu %, θ obmedzíme na obdĺžnik R× T , kde

R = [0, 1
2
√
w2 + h2], T = [0, π)

a kvantujeme delením

0 = r0 ≤ r1 ≤ r2 ≤ . . . < rn = 1
2
√
w2 + h2,

0 = t0 ≤ t1 ≤ t2 ≤ . . . ≤ tm = π,

n,m ∈ N,

pričom z každého podintervalu zvolíme jednu reprezentatívnu hodnotu

%1, %2, . . . , %n,

θ1, θ2, . . . , θm.

Ďalej zavedieme n × m akumulačnú maticu A = [apq], ktorá je na začiatku výpočtu
nulová. V každom kroku numerického riešenia potom skúmame objektový pixel (j, k)
obrazu a hodnotu apq matice A zvýšime o 1, ak

{(θ, %) | % = k cos θ − j sin θ} ∩ [rp−1, rp]× [tq−1, tq] 6= ∅,
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t. j. ak sinusoida daná skúmaným pixelom prechádza zodpovedajúcou bunkou mriežky
získanej delením parametrického priestoru.

Postup opakujeme pre všetky objektové pixely skúmaného obrazu. Reprezentatívne
hodnoty %p, θq podintervalov [rp−1, rp], [tq−1, tq] prislúchajúce maximálným prvkom apq
matice A potom aproximujú parametre % a θ priamok nachadzajúcich sa v obraze – koli-
neárne body v obraze totiž spôsobujú opakovanú inkrementáciu zodpovedajúceho prvku
v akumulačnej matici A.

Obr. 2.16: Sinusoida v parametrickom priestore a jeho delenie mriežkou.

Výpočetná náročnost Houghovej transformácie narastá s počtom parametrov potreb-
ných na určenie detekovaného objektu. Pre prípad priamok je však výpočet relatívne
nenáročný a implementácia je realizovateľná nasledujúcim algoritmom

Algoritmus 2: Houghova transformácia
vstup : Binárny obraz i o rozmeroch h× w
výstup: Obraz h o rozmeroch

√
h2 + w2 × 180

1 Inicializuj obraz h ≡ 0
2 for each objektový pixel p(j, k) obrazu i do
3 for θ := 0 to 180 do
4 ρ := k cos(θ · π/180)− j sin(θ · π/180)
5 r := Round(ρ)
6 h(r, θ) := h(r, θ) + 1
7 end
8 end
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Obr. 2.17: Obraz obsahujúci jeden objektový pixel (vľavo) a zodpovedajúca sinusoida v
parametrickom priestore (vpravo).

Obr. 2.18: Obraz obsahujúci dva objektové pixely (vľavo) a zodpovedajúce sinusoidy v pa-
rametrickom priestore (vpravo). Priesečník týchto kriviek určuje parametre priamky danej
bodmi v pôvodnom obraze.
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3 Predspracovanie obrazových dát
V nasledujúcej kapitole bude opísaný postup predspracovania obrazových dát – skúma-
nými obrazmi sú šedotónové snímky z mikroskopu zachytávajúce vlákna morských rias.
Tieto vlákna sa všeobecne môžu na rôznych miestach v obraze prekrýať a krížiť. Cielom je
dáta pripraviť tak, aby bolo možné jednotlivé vlákna separovať a následne analyzovať ich
vlastnosti. Konkrétne nás zaujíma ich dĺžka – aby sme ju boli schopní odhadnúť, každé
vlákno potrebujeme reprezentovať jednou 8-konektívnou krivkou hrúbky 1 pixel.

Prezentovaný postup predspracovania sa opiera o poznatky z publikácie [15] a za cieľ si
pokladá surové dáta na požadovaný tvar previesť použitím metód uvedených v kapitole 2.
Demonštrovaný bude na vybraných snímkach – prehľad všetkých spracovávaných snímok
sa nachádza v prílohe A.

Obr. 3.1: Snímka 1 Obr. 3.2: Snímka 1 (detail)

3.1 Filtrácia

Spracovávané snímky pochádzajú z digitálnej kamery, a sú tak do určitej miery ovplyvnené
šumom. Tento šum spôsobuje zrnitosť, ktorá sa môže pri prahovaní a následných mor-
fologických úpravách patologicky prejaviť v podobe malých novovzniknutých segmentov
vlákien nevyskytujúcich sa v pôvodnom obraze.

Obr. 3.3: Snímka 1 (detail) pred filtráciou, po aplikácii mediánového filtra a po
aplikácii filtra kĺzavého priemeru.
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Na potlačenie impulzného šumu je použitý 3 × 3 mediánový filter nasledovaný 3 × 3
lineárnym filtrom kĺzavého priemeru

G = 1
9

1 1 1
1 1 1
1 1 1

 ,
ktorý v obraze ďalej potlačuje aditívny šum.

3.2 Segmentácia

Pozorované objekty pozostávajú z pixelov, ktoré majú v porovnaní s pozadím značne
nižšie jasové hodnoty. Snímky sú preto dobre segmentovateľné prahovaním.

Vo väčšine prípadov je možné prahovú hodnotu spoľahlivo stanoviť vizuálnym posúde-
nim histogramu. Kvôli nerovnomernosti osvetlenia v snímke zpôsobenej najmä vinetáciou
však upredňostňujeme adaptívny prístup. Adaptívne prahovanie nám navyše dovoľuje pro-
ces automatizovať uplatnením iteračnej metódy stanovenia optimálneho prahu uvedenej
v časti 2.4, ktorá by pri klasickom prahovaní neposkytovala vhodný výsledok (obr 3.4a).
Obrazy sú tak rozdelené pravidelnou mriežkou na časti prahované samostatne.

(a) (b)

(c) (d)

Obr. 3.4: (a) prahovanie globálnym prahom získaným iteračným výpočtom, (b)
manuálnou voľbou prahu, (c) adaptívne prahovanie s iteračným výpočtom prahu
a (d) adaptívne prahovanie s iteračným výpočtom prahu a odstránením oblastí
s nepostačujúcim rozptylom (snímka 1).
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Nakoľko je prahová hodnota vypočítavaná lokálne a pre každú časť obrazu samostatne,
dochádza k nežiadúcej segmentácií oblastí, v ktorých sa pozorované objekty nenachádzajú
(obrázok 3.4c). Tento jav je napravený stanovením podmienky minimálneho rozptylu ja-
sových hodnôt. Pri použití mriežky n×m deliacej definičný obor obrazu

i : {1, . . . , h} × {1, . . . , w} → {0, . . . , 255}

na podmnožiny

D11 = {1, . . . , h1} × {1, . . . , w1},

D21 = {h1 + 1, . . . , h2} × {1, . . . , w1},
...

Dnm = {hn−1 + 1, . . . , hn} × {wm−1 + 1, . . . , wm},

kde 0 = h0 < h1 < h2 < . . . < hn = h a 0 = w0 < w1 < w2 < . . . < wm = w, sú
vypočítané hodnoty rozptylu

varDnm = 1
|Dnm|

∑
p∈Dnm

(
i(p)− µnm

)2
, kde µnm = 1

|Dnm|
∑

p∈Dnm

i(p),

a hodnota priemerného rozptylu

σ2
min := 1

mn

n∑
j=1

m∑
k=1

Dnm.

Pixel p ∈ Dnm obrazu i je následne vyhodnotený ako objektový vtedy, ak vyhovuje
predpisu 2.4 a oblasť Dnm zároveň splňuje podmienku

varDnm > εσ2
min,

kde ε > 0 je vhodne zvolená reálna konštanta citlivosti.

3.3 Morfologická rekonštrukcia

Prahovaním bol získaný binárny obraz rozlišujúci objekty – vlákna – od pozadia. Nakoľko
hranica vlákien má na snímkach pozorovateľne nižšiu jasovú hodnotu ako ich vnútro, pri
prahovaní dochádza k chybnému vyhodnoteniu vnútra vlákien ako súčasti pozadia na
miestach, kde je tento rozdiel dostatočne veľký (obrázok 3.5a).

Vzniknuté diery v objektoch je možné vyplniť opakovanou dilatáciou a eróziou. Tento
postup je však aplikovateľný len v prípade, že sa na snímke nenachádzajú miesta, v ktorých
sú dve vlákna blízko seba – dilatácia spôsobí ich umelé spojenie (obrázok 3.5b). Aby
sme javu predišli, použitá je geodetická dilatácia opísaná v časti 2.5.4 (obrázok 3.5d).
Maskovací obraz iX (obr 3.5c) je zostrojený nasledujúcim spôsobom:

(i) Z obrazu získaného prahovním sú odstránené komponenty množiny objektových
pixelov, ktoré obsahujú okrajové pixely1.

1Pixel p = (j, k), ktorý má aspoň jednu súradnicu rovnú jednej, alebo maximálnu.
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(ii) Zvolený je ľubovoľný okrajový pixel p = (j, k).

(iii) Vykonaná je operácia flood fill s počiatočným pixelom p.

(iv) Z obrazu z predchádzajúceho kroku je vytvorený obraz komplementárny.

(a) (b) (c) (d)

Obr. 3.5: (a) detail snímky 2 po prahovaní, (b) spojenie vlákien po dilatácii, (c)
maskovací obraz, (d) geodetická dilatácia.

Takto získaný maskovací obraz je binárnym obrazom, v ktorom objektové pixely tvoria
tie komponenty množiny pixelov pozadia vstupného obrazu, ktoré neobsahujú jeho okra-
jové body. Indikuje tak práve diery, ktoré majú byť vyplnené, a prípadné komponenty
spôsobené krížením vlákien. Tieto komponenty sú odstraniteľné opakovaním kroku (ii)
s vhodnou voľbou p. V skúmaných snímkach to však nebolo nutné. Pre výstupný obraz
i2 tak platí

i2(p) = 1 ⇐⇒ i⊕(p) = 1 ∧ iX(p) = 1,

kde i⊕ je obraz získaný klasickou dilatáciou vstupného obrazu i1, t. j. množina objektových
pixelov M2

O výstupného obrazu i2 je daná

M2
O = (M1

O ⊕X B) = (M1
O ⊕B) ∩MX

O ,

kde B je štruktúrny element

B =

1 1 1
1 1 1
1 1 1

 (3.1)

Geodetická dilatácia je opakovaná do stavu idempotencie, t. j. pokým ďalšie jej opakovanie
už obraz nezmení.

3.4 Stenčovanie a čistenie

Morfologicky rekonštruovaný obraz je následne stenčovaný postupom opísaným v časti 2.5.3.
Stenčovanie je uprednostnené pred eróziou, nakoľko vyžadujeme zachovanie súvislosti
komponent obrazu. Výsledkom je skelet objektov v obraze. S výnimkou miest, kde dochá-
dza k pretínaniu sa vlákien, majú všetky objektové pixely obrazu nanajvýš dva objektové
8-susedné pixely.
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V obraze sa však stále nachádzajú nežiadúce objekty. Vlákna, ktoré nie sú na snímke
zachytené celé, nie je možné z hľadiska ich dĺžky jednoduchým spôsobom analyzovať. Za
predpokladu, že tieto neúplne segmenty predstavujú menej ako 5% obrazových dát, ich je
možné z obrazu odstrániť bez toho, aby bola znehodnotená štatistická interpretácia získa-
ných výsledkov. V opačnom prípade je ich nutné pri štatistickom spracovaní považovať za
cenzorované dáta. Nakoľko však predmetom práce nie je štatistická analýza, ale separácia
pretínajúcich sa kriviek, neúplné vlákna sú z obrazu vždy odstránené.

Obr. 3.6: Obraz po stenčení (vľavo) a po odstránení okrajových objektov (vpravo)

Z obrazu sú následne odstranené aj osamotené pixely, t. j. objektové pixely, ktoré
nemajú ani jeden 8-susedný pixel, ktorý by bol tiež objektový. Odstránenie je vykonané
operáciou uzavretia so štruktúrnym elementom 3.1.
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4 Analýza pretínajúcich sa objektov
V nasledujúcom texte predstavíme algoritmus, ktorý realizuje separovanie kriviek v obraze
získanom postup z predchádzajúcej kapitoly. Začínajúc v jednom z ich koncových bodov
v obraze postupujeme pixel po pixely, zaznamenávajúc každý bod krivky do nového vý-
stupného obrazu. V miestach, kde sa krivky krížia, spájajú alebo rozdeľujú, je nutné
vykonať rozhodnutie o ich náväznosti. Voľba nasledujúceho pixelu trasovanej krivky je
primárne založená na porovnaní sklonu θ priamok, ktoré ju lokálne aproximujú pred a za
miestom kríženia. V miestach, kde sa jedna krivka rozdeľuje na dve je Navyše využitá
informácia o jej minulom chovaní – zohľadnený je predchádzajúci sklon θold a predchádza-
júci smer dold. Nakoniec bude opísaná metóda, ktorou budeme dĺžku separovaných kriviek
odhadovať.

4.1 Trasovanie

Vstupný binárny obraz získaný procesom predspracovania opísanom v predchádzajúej
kapitole označme

i : M → {0, 1} (4.1)

a ďalej zaveďme:

(i) obraz koncových bodov e : M → {0, 1} daný

e(p) =
1 ak i(p) = 1 ∧ |Oi(p)| = 1,

0 inak,

(ii) obraz priesečníkov x : M → {0, 1} daný

x(p) =
1 ak i(p) = 1 ∧ |Oi(p)| > 2,

0 inak,

(iii) obraz oblúkov a : M → {0, 1} daný

a(p) = i(p)− x(p),

(iv) rozšírený obraz koncových bodov e∗ : M → {0, 1} daný

e∗(p) =
1 ak a(p) = 1 ∧ |Oa(p)| = 1,

0 inak,

(v) obraz bodov spojenia s : M → {0, 1} daný

s(p) = e∗(p)− e(p),
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kdeOi(p) je množina 8-susedných objektových pixelov pixelu p obrazu i zavedená v časti 2.1.
Obrazy (i), (iii) a (v) zostrojené z predspracovanej snímky 1 sú zobrazené na obrázkoch 4.1,
4.2 a 4.3.

Obr. 4.1: Obraz oblúkov a (vľavo) a jeho detail (vpravo).

Obr. 4.2: Obraz koncových bodov e (vľavo) a jeho detail (vpravo).

Obr. 4.3: Obraz bodov spojenia s (vľavo) a jeho detail (vpravo).
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Poznamenajme, že vyššie uvedené obrazy sú korektne definované. Rozdiel v predpise
obrazu oblúkov a (iii) je nulový alebo rovný jednej, nakoľko ak x(p) = 1, potom aj
i(p) = 1 ako priamy následok predpisu obrazu x. Analogicky argument platí pre obraz
bodov spojenia s. Nakoniec označme E,X,A, S množiny objektových pixelov obrazov
e, x, a, s.

Algoritmus trasovania je cyklický a po-
zostáva z niekoľkých procedúr. Vstupom
je binárny obraz 4.1. Vytvorený je vý-
stupný binárny obraz o : M → {0, 1}
daný

o(p) = 0 pre všetky p ∈M

a zvolený je počiatočný bod p ∈ E.
Následne je volaná procedúra Trasovať
(obr 4.10), ktorá „posúva“ bod p po ak-
tuálne trasovanej krivke v obraze a. Po
každom novom zvolení bodu p je tento
bod pridaný do množiny objektových pi-
xelov výstupného obrazu o, t. j.

o(p)← 1.

Procedúra Trasovať je volaná opako-
vane do vtedy, kým bod p nie je kon-
covým bodom krivky. Tento proces je
opakovaný pre každý počiatočný bod
z množiny E. Výstupom je potom sek-
vencia obrazov o, z ktorých každý obsa-
huje práve jednu digitálnu krivku repre-
zentujúcu jedno z vlákien rias z pôvodnej
snímky.

Samotná procedúra Trasovať (obrázok 4.10) pozostáva z dvoch častí. V prvej časti
(obrázok 4.10, kroky 6–9) sú trasované krivky v obraze oblúkov a – na základe aktuálneho
pixelu p je volený pixel nasledujúci, ktorý je vzhľadom k nemu vždy 8-susedný. Nakoľko
pre množinu A objektových pixelov obrazu a platí

1 ≤ |Oa(p)| ≤ 2 pre všetky p ∈ A,

nasledujúci pixel je vždy určený jednoznačne ako také q ∈ Oa(p), ktoré nebolo vyhod-
nocované v minulom kroku (obrázok 4.4). V druhej časti (obrázok 4.10, kroky 12–14) je
volaná procedúra Rozhodni, ktorá rieši rozhodovanie v miestach spájania, rozchádzania
sa alebo kríženia sa vlákien. Tieto miesta sú detekované ako body, ktoré majú iba jeden
8-susedný pixel objektový v obraze a a zároveň nie sú objektové v obraze koncových bodov
e.
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Obr. 4.4: Výber nasledujúceho pixelu v krokoch 6–9 procedúry Trasovať

Kríženie vlákien v snímke sa v predspracovanom binárnom obraze i prejavuje dvomi
spôsobmi – dochádza k dvom rôznym vzorom, ktoré budeme nazývať x-priesečník a y-
priesečník. V prvom prípade je miesto kríženia charakterizované lokálnou prítomnosťou
4 bodov spojenia, zatiaľ čo v druhom prípade sú lokálne prítomné len 3. Primárne, x-
priesečníky vznikajú v miestach, kde sa prekrývajúce vlákna rozchádzajú. Okrem toho
však následkom stenčovania v časti 3.4 degenerujú na x-priesečníky aj miesta, kde sa
vlákna pretínajú pod dostatočne ostrým uhlom.

(a) (b)

Obr. 4.5: (a) x-priesečník, (b) y-priesečník

Procedúra Rozhodni má dve varianty. V prípade, že nepoznáme informáciu o pred-
chádzajúcom správaní sa krivky alebo pri prechode algoritmu x-priesečníkom je nasledu-
júci pixel volený na základe sklonu θ priamky, ktorá aproximuje segment vhodnej dĺžky
krivky do priesečníku vstupujúcej. Tento sklon je porovnávaný so sklonom odpoveda-
júcim segmentom výstupným a preferovaný je ten segment, ktorý minimalizuje vhodne
definovanú vzdialenosť sklonov.

(a) (b) (c) (d)

Obr. 4.6: (d) detail obrazu oblúkov a snímky 1, (a) vstupný segment, (b) prvý výstupný
segment, (c) druhý výstupný segment
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Vyššie spomenutý sklon je získaný Houghovou transformáciou opísanou v časti 2.7.
V obrazoch 4.6a–4.6c sú detekované priamky

% = x cos θ + y sin θ, (4.2)

ktorých parametre sú aproximované priesečníkom v sinusoidálnych kriviek v parametric-
kom priestore na obrázkoch 4.7a–4.7c.

(a) (b)

(c)

Obr. 4.7: Výsledok Houghovej transformácie (a) segmentu 4.6a, (b) segmentu 4.6b, (c)
segmentu 4.6c. Počet priesečníkov môže byť všeobecne vačší ako 1. V tom prípade je
hodnota parametru θ odčítaná ako hodnota ich geometrického stredu, t. j. aritmetického
priemeru ich súradníc.
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Tieto priamky považujeme za lokálnu aproximáciu odpovedajúcich segmentov krivky.
Z Houghovej transformácie však nemáme informáciu o smere a veľkosť uhla θ nadobúda
len hodnoty z intervalu dĺžky π. Pri porovnávaní veľkosti uhlov je tak nutný modulárny
prístup. Uvažovať budeme θ ∈ [0, π).

π ≡ 0
θ2

θ
1ϱθ

φθ

Obr. 4.8: Rozdiel sklonu priamok

Označme θ1 sklon odpovedajúcí vstupnému a θ2, θ3 výstupným segmentom krivky. Ako
je vidieť na obrázku 4.8, kde θ2 > θ1, požadovaná hodnota vzdialenosti nemôže byť ϕθ,
ale %θ. Vypočítané sú preto hodnoty %θ(θ1, θ2), %θ(θ1, θ3), kde

%θ(a, b) := min{|b− a|, π − |b− a|}. (4.3)

Poznamenajme, že takto definované %θ je metrikou. Následne je zvolený nasledujúcí pixel
p tak, aby p patrilo k-temu výstupnemu segmentu krivky, ktorý je zvolený tak, aby pre
odpovedajúci sklon θk platilo

θk = argmink %(θ1, θk), kde k ≥ 2. (4.4)

Po prechode priesečníkom je hodnota θ1 je uložená do premennej θold. Táto hodnota je
zohľadňovaná druhou variantou procedúriRozhodni, ktorá je volaná vtedy, ak algoritmus
vyhodnocuje y-priesečníky (a θold existuje). Postup je analogický ako v prípade varianty
prvej s tým rozdielom, že za vstupný sklon je považovaná práve hodnota θold.

(a) (b) (c) (d) (e)

Obr. 4.9: (a) vzor spôsobujúci zacyklenie, (b), (c), (d), (e) segmenty krivky
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V určítých prípadoch môže trasovaná krivka vytvárať vzory, ktoré vedú na zacyk-
lenie algoritmu. K tomuto javu dochádza napríklad v prípade vyzobrazenom na ob-
rázku 4.9a. Pri trasovaní začínajúc ľavým okrajovým pixelom obrazu je po prechode
prvým y-priesečníkom uložená hodnota θold (segment na obrázku 4.9b), ktorá je však
takmer totožná so sklonom pravej polovice segmentu na obrázku 4.9d a pri prechode
druhým y-priesečníkom teda vyhovuje vzťahu 4.4.

Obr. 4.10: Procedúra Trasovať

Aby sme zacykleniu predišli, stanovená je podmienka dominatného smeru. Vyhodno-
cované segmenty sú krivky

p1, . . . , pn, kde pk = (p1
k, p

2
k), pre k = 1, . . . , n. (4.5)
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Nakoľko však postupnosti p1, . . . , pn a pn, . . . , p1, definujú tú istú krivku, bod p1 je kvôli
jednoznačnosti vždy volený ako prvý trasovaný pixel daného segmentu. Zostrojený je
smerový vektor

v = pn − p1 = (p1
n − p1

1, p
2
n − p2

1) = (v1, v2). (4.6)

pre každý z uvažovaných segmentov a dominatný smer

d := argmaxk∈{1,2} vk. (4.7)

pre segment vstupujúci. Pri prechode priesečníkom potom vyžadujeme, aby d-ta zložka
vstupujúceho a vystupujúceho smerového vektoru v mali rovnaké znamienko. Tento po-
stup zacykleniu zabránil vo všetkých spracovávaných snímkach.

Obr. 4.11: Snímka A (vľavo) a výsledná separovaná krivka vo výstupnom obraze o (vpravo)

V kroku 17 algoritmu Rozhodni (obrázok 4.12) je volený nasledujúci bod p z množiny
S(p), ktorú definujeme

S(p) := {q ∈ S : q ∈ Oε(p)} (4.8)

pre vhodne zvolené ε ∈ R+. Množina S(p) je teda tvorená bodmi spojenia, ktoré sa nachá-
dzajú v okolí pixelu p. Okrem vyššie uvedených kritérií, na základe ktorých je vykonávané
rozhodovanie v miestach priesečníkov, je Navyše zohľadnená informácia o tom, či seg-
ment, po ktorom sa má algoritmus vydať, už patrí niektorej z kriviek separovaných v jeho
predchádzajúcich cykloch, t. j. či pre niektorý z výstupných obrazov o platí

o(q) = 1. (4.9)

Pri voľbe p sú preferované také body, ktoré ešte žiadnej separovanej krivky nepatria.
Ak takéto body neexistujú, podmienka je ignorovaná a nový bod p je volený z celej
množiny S(p).
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Obr. 4.12: Procedúra Rozhodni.

Nakoľko trasovanie je vykonávané na pixeloch obrazu oblúkov a, ktorý neobsahuje
body priesečníkov, výsledný obraz o tieto body neobsahuje tiež. Tieto „medzery“ (obrá-
zok 4.13a) sú prepojené opakovaním operácií dilatácie (obrázok 4.13b) a stenčenia (obrá-
zok 4.13c), čím zároveň dochádza k miernemu vyhladeniu výslednej krivky.

(a) (b) (c)

Obr. 4.13: (a) detail výstupného obrazu o, (b) po dilatácii a (c) po následnom stenčení

4.2 Estimácia dĺžky

Množina objektových pixelov MO výstupného obrazu určuje všeobecne viac ako jednu
krivku podľa definície 2.1.4. Ak však vyslovíme ľahko pochopiteľný predpoklad, že poža-
dovaná krivka je jednoduchá a má dĺžku n = |MO|, potom je (až na zámenu poradia jej
prvkov) určená jednoznačne. Označme túto krivku

C = (p0, . . . , pn). (4.10)

Následkom stenčovania v časti 3.4 táto krivka podhodnocuje skutočnú dĺžku riasového
vlákna – vlákno je stenčované rovnomerne po svojom obvode, a jeho pôvodné koncové
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body sú tak posunuté. Krivku C preto na oboch koncoch predĺžime o m bodov, pričom
m je najväčšie prirodzené číslo splňujúce((

{p0, pn} ⊕B
)
. . .⊕B

)
︸ ︷︷ ︸

m-krát

⊆M ′
O, (4.11)

kde M ′
O je množina objektových pixelov obrazu získaného morfologickou rekonštrukciou

v časti 3.3 a B je štruktúrny element

B =

× 1 ×
1 1 1
× 1 ×

 . (4.12)

Množina koncových bodov {p0, pn} krivky 4.10, ktorá je následkom vlastností operácie
stenčovania podmnožinou množiny objektových pixelov M ′

O morfologicky rekonštruova-
ného obrazu, je teda opakovane dilatovaná do stavu, keď už podmnožinou M ′

O nie je. Za-
znamenaný je počet opakovaní m, ktorý je pritom vykonaný. Tým je získaná informácia
o počte krokov stenčovania, ktoré boli vykonané v rámci predspracovnia, pred dosiahnutím
idempotencie v okolí koncových bodov vlákna.

Obr. 4.14: (a) Posunutý koncový bod p0 krivky C a množina objektových pixelov M ′
O

obrazu získaného v časti 3.3, (b) 2-krát opakovaná dilatácia množiny {p0}.

Tieto body sú potom ku krivke C pridané v smere danom rozdielom súradníc jej
posledných dvoch bodov. Upravená krivka je potom;

am, . . . , a1, a0 = p0, . . . , pn = b0, b1, . . . , bm, (4.13)

kde
a0 = p0,

ak = ak−1 + (p0 − p1),
b0 = pn, (4.14)
bk = bk−1 + (pn − pn−1),
pre k = 1, . . . ,m.
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Obr. 4.15: Predĺžená krivka C.

Preznačme body takto predĺženej digitálnej krivky q1, . . . , qN . Mnohé známe metódy
estimácie dĺžky kriviek v digitálnom obraze sú založené na ich interpolácií polynómom
alebo splajnom – pozorovaním však vidíme, že skúmané vlákna rias pozostávajú z rovných
článkov a hladká (analytická) krivka tak nevystihuje ich charakter. Navyše, k určitej
miere vyhladenia došlo už pri predchadzajúcich operáciách dilatácie a stenčovania. Na
odhad dĺžky je volená metóda upravujúca súradnice bodov q1, . . . , qN krivky 4.13 váženým
priemerom podľa predpisu

xk =


q1 ak k = 1,
qN ak k = N,

w(qk−1 − qk) + qk + w(qk+1 − qk) inak,
(4.15)

kde w ∈ [0, 1] je váha. Za výsledný odhad ` sa potom ukazuje byť vhodné [14] považovať
sumu euklidovských vzdialeností

` = α
n∑
k=1

%2(xk−1, xk) = α
n∑
k=1

√(
x1
k − x1

k−1

)2
+
(
x2
k − x2

k−1

)2
. (4.16)

kde α ∈ R je konštanta zohľadňujúca mierku pôvodnej snímky.

q2
x2

q1
x1

q5
x5

x3

x4

q3
q4

Obr. 4.16: Body xk upravujúce súradnice pixelov qk s váhou w = 0.5 podľa vzťahu 4.15.
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5 Výsledky
Postupom prezentovaným kapitolách 3 a 4 bola pre každé separované vlákno v snímkach
A, B, C a D vypočítaná

(i) hodnota n vyjadrujúca dĺžku odpovedajúcej jednoduchej digitálnej krivky podľa
definície 2.1.4, (t. j. počet pixelov krivky),

(ii) hodnota l vyjadrujúca odhad dĺžky tejto krivky podľa vzťahu 4.16 pri α = 1.

Výsledné hodnoty sú uvedené v tabuľke 5.1. Samotné snímky a vybrané separované vlákna
sa nachádzajú v prílohe A.

Tabuľka 5.1: Výsledné hodnoty n a l vlákien rias v snímkach A, B, C a D.

Snímka Vlákno n l

A I 100 106,03
II 27 31,21
III 128 141,72
IV 1400 1643,55
V 2578 2852,91
VI 129 135,21
VII 177 183,44
VIII 48 55,1

B I 837 991,05
II 100 133,67
III 45 53,70
IV 22 21,24

C I 39 39,18
II 536 603,75
III 472 536,99
IV 2373 2704,90
V 1417 1646,02
VI 345 388,16
VII 315 367,1
VIII 179 206,27

D I 349 369,56
II 691 805,61
III 1755 1979,46
IV 605 652,17
V 112 120,63
VI 30 37,16

Postupom predspracovania uvedenom v kapitole 3 a originálny algoritmom prezento-
vaným v kapitole 4 boli zo snímok A, B, C a D úspešne separované požadované krivky.
Vo všetkých z uvedených prípadov pracoval algoritmus spoľahlivo, replikujúc subjektívne
vnímanie náväznosti vlákien v pôvodných snímkach. Slabou stránkou algoritmu je jeho
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výpočtová náročnosť a požiadavky na operačnú pamäť zariadenia. Aj keď samotná Houg-
hova transformácia náročná nie je, v priebehu algoritmu je vytváraný a ukladaný veľký
počet nových obrazov (obraz koncových bodov, obraz priesečníkov, ...). S rastúcimi roz-
mermi vstupného obrazu potom rýchlo narastá aj časová a výpočtová náročnosť algoritmu.
Tomuto problému je však možno predísť – rozmery vstupných obrazov je možné reduko-
vať prevzorkovaním. Za predpokladu, že týmto prevzorkovaním nedochádza k narušeniu
spojitosti objektov na snímke, sa výsledok algoritmu nezmení.
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Záver
Práca sa zaoberala problematikou separácie pretínajúcich sa digitálnych kriviek v binár-
nom obraze. Predstavený bol algoritmus vykonávajúci detekciu a separáciu týchto kriviek.
Houghova transformácia, ktorá je nástrojom na detekciu priamok v obraze, bola v algo-
ritme uplatnená novým spôsobom – na aproximáciu „sklonu“ krivky v mieste jej kríženia
sa s krivkou inou.

Prezentovaná bola metodika prípravy konkrétnych obrazových dát. Spracovávané boli
snímky z mikroskopu zachytávajúce vláknité sinice Nostoc, ktoré sa v obraze na viace-
rých miestach pretínajú. Prostredníctvom lineárnej filtrácie, segmentácie, morfologických
operácií a numerických metód boli obrazové dáta pripravené na spracovanie originálnym
algoritmom.

V kapitole 1 bol uvedený matematický aparát tvoriaci teoretický základ metód a po-
stupov, ktoré boli v práci použité. Prezentovaná bola primárne teória z oblasti binárnych
relácií a metrických priestorov. V kapitole 2 bol definovaný digitálny obraz, jeho vlast-
nosti a vybrané numerické metódy, ktoré sú v práci použité. V kapitole 3 bol opísaný
konkrétny postup, akým boli surové snímky upravené pred tým, než z nich boli separo-
vané jednotlivé krivky reprezentujúce vlákna siníc. V kapitole 4 bol predstavený samotný
algoritmus, ktorý vykonáva separáciu digitálnych kriviek v binárnom obraze. Výsledky
práce boli zhrnuté v kapitole 5.
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A Snímky
Na nasledujúcich obrázkoch sú vyzobrazené snímky rias, ktoré boli spracovávané, a vy-
brané vlákna, ktoré boli zo snímok separované.

Obr. A.1: Snímka A Obr. A.2: Snímka B

Obr. A.3: Snímka A, vlákno IV Obr. A.4: Snímka B, vlákno I

Obr. A.5: Snímka A, vlákno IV Obr. A.6: Snímka B, vlákno II
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Obr. A.7: Snímka C Obr. A.8: Snímka D

Obr. A.9: Snímka C, vlákno II Obr. A.10: Snímka D, vlákno III

Obr. A.11: Snímka C, vlákno IV Obr. A.12: Snímka D, vlákno IV
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B Opis vytvoreného softvéru
V rámci práce bol vytvorený vlastný softvér vo vývojovom prostredí Delphi 7. Softvér je
určený na spracovávanie obrazových dát vo formáte 8-bitových .BMP súborov so šedotó-
novou paletou, pričom vykonáva všetky operácie a metódy spracovania obrazu uvedené v
kapitolách 2, 3 a 4.

Obr. B.1: Hlavné okno softvéru

Obrazové súbory formátu .BMP, ktoré majú byť upravované, je potrebné pridať do
zoznamu súborov v hlavnom okno zvolením možnosti File > Add image(s). Pridať je
možné viacero súborov zároveň.

Obr. B.2: Okno s otvoreným súborom

Označením jedného zo súborov v zozname a následným zvolením možnosti File >
Process selected image sa otvorí nové okno s náhľadom otvoreného .BMP súboru a s
ponukou nástrojov na jeho spracovávanie.
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Možnosť

— View > True size zobrazí spracovávaný obraz v jeho skutočnej veľkosti.

— View > Fit to window prispôsobí rozmery spracovávaného obrazu aktuálnym roz-
merom okna. Obraz samotný nie je upravovaný, jedná sa len o jeho zobrazenie.

— View > Fit to window prispôsobí rozmery okna aktuálnym rozmerom spracováva-
ného obrazu.

— Image > Save ukladá aktuálny stav obrazu do nového, alebo pôvodného .BMP sú-
boru.

Obr. B.3: Ponuka nástrojova
bol

Nástroje vykonávajúce numerické metódy spracovania obrazu sa nachádzajú v záložke
Image. Možnosť

— Image > Mean vyhladzuje obraz lineárnym filtrom kĺzavého priemeru s konvolučným
jadrom 3× 3.

— Image > Median vyhladzuje obraz mediánovým filtrom 3× 3.

— Image > Threshold vykonáva prahovanie obrazu.

— Image > Erode resp. Image > Dilate vykonávajú eróziu, resp. dilatáciu obrazu
štruktúrnym elementom 2.6.

— Image > Thin vykonáva jednu iteráciu sekvenčného stenčenia postupnosťou štruk-
túrnych elementov 2.8. Na opakovanie stenčovania je možné využiť klávesovú skratku
CTRL + T. Stenčovanie je nutné zakončiť možnosťou Image > Finish thinning.

— Image > Remove edge objects odstraňuje z obrazu objekty dotýkajúce sa jeho
okrajov.
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— Image > Dilate inside vykonáva geodetickú dilatáciu s maskou opísanou v časti 3.3.
Pred geodetickou dilatáciou je nutné odstrániť objekty dotýkajúce sa okrajov ob-
razu.

— Image > Remove stray pixels odstraňuje osamotené objektové pixely využitím
operácií otvorenia a uzavretia.

— Image > Trace vykonáva separáciu kriviek v obraze. Pred použitím možnosti Trace
je nutné, aby obraz obsahoval iba krivky široké 1 pixel a neobsahoval objekty do-
týkajúce sa jeho okrajov. Separácia môže trvať niekoľko desiatok minút a výsledné
separované krivky sú ukladané ako samostatné .BMP súbory do priečinku, v ktorom
sa nachádza práve spracovávaný .BMP súbor.

— Image > Restore endpoints predlžuje separovanú krivku tak, aby jej dĺžka od-
povedala dĺžke jej zodpovedajúceho objektu v pôvodnom obraze (vysvetlenie sa
nachádza v časti 4.2).

Záložka Analyze obsahuje jedinú možnosť Calculate length. vyčíslujúcu hodnoty n a l
opísané v časti 4.2. Na výpočet týchto hodnôt je nutné, aby otvorený obraz obsahoval iba
jednu krivku širokú 1 pixel. Výsledky z kapitoly 5 je možné reprodukovať nasledujúcou
postupnosťou operácií:

(i) vyhladenie nástrojom Mean filter alebo Median filter

(ii) prahovanie nástrojom Threshold,

(iii) morfologická rekonštrukcia opakovaným použitím nástroja Dilate inside,

(iv) iteračné stenčenie opakovaným použitím nástroja Thin,

(v) odstránenie patologických štruktúr opakovaným striedaním nástrojov Dilate a Thin,

(vi) odstránenie okrajových objektov nástrojom Remove edge objects,

(vii) separácia kriviek nástrojom Trace,

(viii) spojenie a vyhladenie separovaných kriviek opakovaným striedaním nástrojov Dilate
a Thin,

(ix) predĺženie kriviek nástrojom Restore endpoints a konečný výpočet nástrojom
Calculate length.

K práci sú okrem samotného softvéru priložené snímky A, B, C a D vo formáte .BMP.
Rozmery priložených snímok sú zredukované prevzorkovaním metódou bilineárnej inter-
polácie.
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